GRASS 4.0 Map Digitizing Manual:
v.digit

Craig A. Neidig
David Gerdes
Chester Kos

U.S. Army Corps of Engineers
Construction Engineering Research Laboratory
Environmental Division
Spatial Analysis Systems Team
P.O. Box 9005
Champaign, IL 61826-9005

December 1991
FOREWORD

This document was developed for the U.S. Department of Agriculture Soil Conservation Service’s Cartography & GIS Division (USDA SCS-CGIS) under reimbursable work unit VI1, entitled "FAEN-GRASS Enhancements." The Technical Monitor was Richard Liston, of USDA SCS-CGIS.

This work was performed by the Environmental Division (EN) of the U.S. Army Construction Engineering Research Laboratory (USACERL). Dr. Edward Novak is Acting Chief of USACERL-EN, and William D. Goran is USACERL-EN Spatial Analysis Systems (SAS) Team Leader. David Gerdes, of USACERL-EN’s SAS Team, was the Principal Investigator for this work unit. The USACERL Technical Editor was William Wolfe, Information Management Office.

COL Everett Thomas is Commander and Director of USACERL, and Dr. L.R. Shaffer is Technical Director.
ACKNOWLEDGEMENTS

The authors wish to acknowledge and thank the following individuals for their contributions toward the completion of this work. Craig Neidig conveys special thanks to David Gerdes for his explanations of some of the more subtle idiosyncrasies of the v-digit program. Accolades to Mary Martin for her months of patience while the manual was this close to being finished and her editorial panache. Many thanks to Melissa Records, Jeff Rogers, and Scott Wade at USACERL, and the staffs of the Cartography and GIS Division and the National Cartographic Center of the USDA Soil Conservation Service, who reviewed the manuscript and provided constructive criticism. Thanks also to the remainder of the USACERL Environmental Division’s Spatial Analysis Systems Team (USACERL-ENY), with special thanks to Michael Higgins, Chester Kos, Marilyn Ruiz, and Jean Messersmith.
Table of Contents

Foreword .................................................................................................................................................. 2
Acknowledgements ................................................................................................................................. 3
Table of Contents .................................................................................................................................. 4
1. Introduction .......................................................................................................................................... 5
2. Using GRASS for Map Development ................................................................................................. 7
3. Preparing a Map for Digitizing ........................................................................................................... 8
4. Using the Mouse and the Digitizing Cursor ......................................................................................... 8
5. Entering v.digit ...................................................................................................................................... 9
6. The Main Menu ..................................................................................................................................... 18
7. The Digitize Menu ............................................................................................................................... 20
8. The Edit Menu ..................................................................................................................................... 28
9. The Label Menu ................................................................................................................................... 31
10. The Customize Menu ......................................................................................................................... 36
11. The Color Menu ................................................................................................................................. 39
12. The Display Menu ............................................................................................................................... 41
13. The Toolbox Menu .............................................................................................................................. 43
14. The Window Menu ............................................................................................................................. 45
15. The Zoom Menu .................................................................................................................................. 47
16. The Debug Menu ................................................................................................................................. 49
17. Exiting v.digit ....................................................................................................................................... 51
18. Conclusions and Recommendations ................................................................................................. 52
19. References .......................................................................................................................................... 53
GRASS 4.0 MAP DIGITIZING MANUAL: V.DIGIT

1. INTRODUCTION

1.1. Background

The Geographic Resources Analysis Support System (GRASS) is a public domain, image processing and geographic information system (GIS) originally developed by researchers in the Environmental Division of the U.S. Army Corps of Engineers Construction Engineering Research Laboratory (USACERL-EN) in Champaign, IL. The system is used to input, manipulate, analyze, and output geographic data by users in both military and nonmilitary and public and private agencies based in North America, Europe, and other parts of the world. v.digit is a robust map development software package used for vector digitizing, editing, and labeling, and the conversion of vector data to raster format. This document details the capabilities of v.digit, a highly interactive, menu driven, map digitizing package included among GRASS software.

Although most GRASS development has been conducted at USACERL, system integration, development, testing, distribution, training, and support is performed by numerous publicly and privately-operated sites throughout the world. GRASS version 4.0 implemented significant additions and modifications to system libraries and programming code. This document reflects modifications made to GRASS version 4.0 map development programs.

1.2. Objective

The objective of this work is to guide the user through the process of using v.digit to develop a GRASS database.

1.3. Approach

Current GRASS v.digit map development and data import/export functions are examined in this report.

1.4. Scope

This document discusses the 4.0-release version of the GRASS v.digit program, completed in the Summer of 1991. Some elements of this document will be out of date and inaccurate for post-4.0 software releases. Additionally, although it is planned that future releases of GRASS issued by USACERL and the USDA SCS will be identical, they may offer somewhat different functions in GRASS 4.0. The functions described in this tutorial are those of the USACERL GRASS 4.0 release, available to all GRASS users.
1.5. Mode of Technology Transfer

GRASS is being transferred to the field through the following mechanisms: training programs, a user support center, newsletters, extensive documentation, institutional structures at the Army and interagency levels, communication networks, and other forums.

User feedback on GRASS program capabilities, documentation, and other technology transfer mechanisms is important to the development of the system. Users are encouraged to communicate such feedback to GRASS development staff at USACERL, via existing electronic communication networks and via the GRASS Information Center at USACERL, P.O. Box 9005, Champaign, IL 61826-9005; phone 217-373-7220; fax 217-373-7222; or e-mail grassbug@zorro.cecer.army.mil.
2. USING GRASS FOR MAP DEVELOPMENT

A great amount of information is stored on paper maps. Such data are useful when building a geographic information system (GIS) database; however, managing the large quantities of data needed can be cumbersome. Map information can be more easily manipulated in digital form by a computer. Within the GRASS Geographic Information System, map development entails the production of vector, raster, and support files that are used within GRASS to represent map features. One way analog map data is entered and converted into digital form is by manually tracing relevant map features with an electronic instrument called a digitizer. In GRASS version 4.0, the program used to conduct this conversion is called v.digit.

The v.digit program is an interactive, menu driven, vector digitizing, labeling, and editing package. This manual discusses the v.digit options and guides the user through a sample digitizing session. To follow the examples in this manual, the user will need a workstation minimally consisting of a graphics monitor and keyboard, a pointing device (mouse), and a digitizing tablet. An ASCII (dumb) terminal with keyboard is optional for some hardware platforms, but is recommended so that the graphics monitor is dedicated to display during the digitizing session. Currently, v.digit drivers have been written for Altek, Calcomp, GeoGraphics, Hitachi, Kurta, Numonics, and SummaGraphics digitizers. v.digit also operates in an X Windows environment. An X-interface to all GRASS programs is currently under development.

It is assumed that the user is familiar with the UNIX environment, GRASS, and in particular with the concepts of vector maps, raster maps, map layers, geographic regions, reference frames, and GRASS locations and mapsets. For a review of these concepts refer to An Introduction to GRASS 4 (Westervelt and Goran, 1991).

Experienced GRASS users should note that the map development modules used in GRASS 4.0 are essentially the same as their predecessors, with some minor modifications and function enhancements. Program names incorporate the new prefix standard adopted for GRASS 4.0; see GRASS 4.0 Programs (Westervelt, Martin, and Brinegar, 1991) for a synopsis of this naming scheme. GRASS 4.0 programs used for map development include:

v.digit, v.import, v.support, v.in.ascii, v.out.ascii, and v.to.rast

These programs are discussed in detail in the GRASS 4.0 User’s Reference Manual (Westervelt, Shapiro, et al., 1991).
3. PREPARING A MAP FOR DIGITIZING

Frequently, map data cannot be digitized directly from original source maps. Paper maps may contain wrinkles, creases, or tears. Heat and humidity cause shrinking and swelling of unstable media which can adversely affect the accuracy of the digital representation. Also, analog maps generally contain many types of thematic information. The analyst must know exactly what map features are to be digitized. To avoid confusion, the user may need to prepare a separate map or maps containing only those features relevant to the database before digitizing. See Cartographic Issues in the Development of a Digital GRASS Database (Ruiz and Messersmith, 1990) for an explanation of how maps should be properly prepared for digitizing, and section 5.1 of this paper for a discussion of map registration and geo-referencing.

The following items should be considered before digitizing commences:

- Use a stable medium (preferably mylar, plastic, etc.) on which the features to be digitized have been rendered clearly and accurately.
- Use drafting tape to secure the medium to the digitizing tablet.
- Define a geographic region in a standard coordinate system (UTM, latitude/longitude, etc.) for the data layer.
- On the medium, locate and mark at least four, and up to 10, coordinate pairs (i.e., Easting, Northing) to be used as map registration points.
- Define a reference frame, or "digitizing window," for the area.
- Have another map of the area available for reference.

Affix the map securely to the digitizing surface with drafting tape, making sure that all portions of the map to be digitized fall within the "active" area of the board and within the reach of the digitizing cursor. The active area refers to that portion of the tablet in which digitized points can be collected. (Most digitizers have a buffer, or "dead" area, near their edges where the cursor will not collect points.) By placing the map to be digitized near the center of the board, this problem can be avoided. For extremely large maps that extend beyond the active area of the digitizing tablet, the map may have to be digitized in pieces; the user must provide a set of map registration points for each map piece. The map should be taped down with the sides approximately parallel to the bottom and sides of the board. Most digitizing programs, including v.digit, have transformation algorithms that will adjust for small deviations in registration between the map coordinates and board coordinates. However, if the maps are severely skewed on the board, then inaccuracies with registration and subsequent collection of point coordinates will occur.
4. USING THE MOUSE AND THE DIGITIZING CURSOR

Many *v.digit* options make use of a pointing device (mouse). A mouse usually has three buttons: left, center, and right. (Some mice may have only two buttons; in these cases, use of the middle button is usually emulated by pressing the left, then right, mouse buttons in quick succession.) Once the mouse is activated, movement of the mouse corresponds to movement of a pointer on the graphic monitor screen. In *v.digit*, the pointer appears as a movable box or an arrow depending on the function specified by the user. Movement of the mouse is used to identify an object or to define an area shown on the monitor. Most *v.digit* operations using the mouse follow a *left-right* sequence for first *choosing*, and second, *accepting* the functions. In most functions, the middle button ends or aborts use of the mouse.

Digitizing is the process of converting analog map data into digital form by tracing the desired features with a digitizer cursor, sometimes referred to as a "puck." The cursor consists of a transparent viewfinder or "sight" and a pad containing a set of buttons or keys. Generally, the sight is a clear plastic lens on which two perpendicular intersecting lines or concentric circles are superimposed. The keys are labeled with letters and/or numbers that correspond to various functions within the digitizing program. The user looks through the sight, much as with a rifle scope, to target the appropriate feature to be digitized, and presses the keys to execute the appropriate digitizing function.
5. ENTERING v.digit

To use v.digit, the user must be in GRASS 4.0 and have entered the proper LOCATION, MAPSET, and DATABASE in which to work. Help with the start-up procedure and a full explanation of these terms are available in the GRASS 4.0 User’s Reference Manual (Westervelt, Shapiro, et al., 1991).

Once in the proper mapset, the user sees a GRASS default prompt similar to the one below.

```
Mapset <grassuser> in Location <somewhere>
GRASS 4.0
```

After the prompt, initiate the v.digit program by entering the command:

```
v.digit
```

The first message to appear upon entering v.digit is a list of the AVAILABLE DIGITIZERS (i.e., those for which device drivers have been installed on the system). See the sample screen below.

```
Available Digitizers

Name: Description:
[1] acme Acme digitizer
[2] none Run digit without the digitizer.

Hit return to use digitizer in brackets below
or type in number or name of other digitizer.
Select digitizer [none] : 1
Selected digitizer is: acme
```

The v.digit program operates either with or without use of a digitizing board. Most program operations are the same in both modes; in the latter case the mouse then serves as the default digitizing instrument. The user has the option of using the program without the digitizing board by selecting the option [2] none. However, for the purposes of this manual, the user should start by working with a digitizing tablet. Enter the number for the appropriate digitizer at the prompt (here, the fictitious "acme" brand) -- more than one digitizer may be available for selection. If a digitizer has been previously used, it is saved as the default option and appears named in the brackets next time v.digit is run.

Next, the user is prompted for the name of the VECTOR map to be used during the current digitizing session. The user has the option to create a new file or to modify an existing file. If the name specified is not found among the existing files, the program assumes that the user wants to create a new file and asks for confirmation of the new file name. In the following example, the file test is created.
Enter the name of a map to work with.
If name is entered that does not already exist, it
will be created at this time.

DIGIT FILENAME
Enter 'list’ for a list of existing digit files
   Hit RETURN to cancel request
   > test
   <test>
   You requested to create new file: 'test'. Is this correct? (y/n) [n] y

The user is next asked if the vector file chosen is geo-referenced in the current LOCATION’s coordinate system. In this manual, the **Universal Transverse Mercator (UTM)** is used as the sample coordinate system.

Current mapset is UTM.
   Is this map in UTM meters? (y/n) [y] y
   Thank You

Creating a new vector file

Other coordinate systems that can be used include an arbitrary (x,y), latitude-longitude, and State Plane. In general, GRASS does not currently permit the user to mix data stored in different coordinate systems under a single LOCATION directory. However, other GRASS programs do enable data within a single LOCATION to be converted to and from various coordinate systems (e.g., **v.transform**, etc.). In **v.digit**, if the user chooses a coordinate system other than the one originally specified for the user’s current GRASS LOCATION, the program responds with the following warning message and automatically returns to the GRASS prompt:

**Sorry, GRASS does not currently support mixing map units.**

If the coordinate systems are not the same, then some type of coordinate transformation needs to be performed. The user should be aware of the coordinate systems of the maps being considered. Refer to the GRASS program **g.help** and to Ruiz and Messersmith, 1990 for a discussion of map coordinate systems, projections, and data conversions.

The next screen appears:
Provide the following information:

Your organization  US Army Const. Eng. Rsch. Lab
Today's date (mon, yr) ________________________
Your name ________________________________
Map's name ________________________________
Map's date _________________________________
Map's scale ________________________________
Other info __________________________________
Zone _____
West edge of area  590000
South edge of area  4941000
East edge of area  609000
North edge of area  4928000

AFTER COMPLETING ALL ANSWERS, HIT <ESC> TO CONTINUE

This screen contains information about the vector file. A newly created layer initially contains several blank lines. The coordinates on this page define a "digitizing region"; they are automatically entered and are originally derived from the default region coordinates in the PERMANENT mapset for the present LOCATION. The user can find the default region coordinates by executing the GRASS command g.region -dp prior to entering the v.digit program. The user should be careful to make sure that this region incorporates the area of the new vector file; generally, the default is more than adequately large. Remember too, that data physically can be digitized outside of the default region but it will not be visible to the user unless the region is expanded to include it. A sample screen with the categories filled in is presented below; use the Enter/Return key to move around the screen:

Provide the following information:

Your organization  USA-CERL
Today's date (mon, yr)  7/04/91
Your name  U.D. Grassuser
Map's name  Test for v.digit
Map’s date  1991
Map’s scale  1:24000
Other info  USGS topo, 1 of 2
Zone  13
West edge of area  590000.00
South edge of area  4941000.00
East edge of area  609000.00
North edge of area  4928000.00

AFTER COMPLETING ALL ANSWERS, HIT <ESC> TO CONTINUE

After typing in the relevant information on this screen, press the <ESCAPE> key to continue the digitizing session.
The following message appears:

<table>
<thead>
<tr>
<th>Shall we continue? [y]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Writing plus file . . .</td>
</tr>
</tbody>
</table>

Press the Enter/Return key to continue. The string "Writing plus file . . ." means that a dig plus file is being created for the new vector file. This file pertains to the spatial topology of the vector data to be created and references the vector data to the appropriate coordinate system. Once created, the dig plus files are not directly modifiable unless the vector file is changed using other options (e.g., v.support). This message does not appear if a previously created vector file is chosen. Answering "no" (or simply "n") at this time exits the user from v.digit. However, the header information entered at the beginning of the current session will be saved.

5.1. REGISTERING THE MAP

The next step is to geo-reference the map to a particular geographic coordinate system (i.e., to the coordinate system previously specified by the user--here, UTM). This is done by selecting a series of registration points, a convenient source of which is the intersection of UTM grid lines. Some U.S. Geological Survey (USGS) 7.5' quad sheets (1:24000 scale) and most Defense Mapping Agency (DMA) installation maps (1:50000 scale) have these grids inscribed on them. However, most USGS quads only have the UTM grid ticks demarcated along the border of the map. In the latter case, the user has to use a straightedge and pencil to carefully draw in the grid intersection for each point. Sometimes the analyst is confronted with a map in which no arbitrary coordinate grid is represented, or maps of less than superior quality (such as a photocopy or blue-line drawing). In such cases, the analyst may have to derive registration points from other maps by cross-registering the "bad" map to the "good" map (e.g., using obvious physical features visible on both maps such as road intersections, bench marks, etc.). Needless to say, this can be a tedious and frustrating endeavor; the registration process often involves more than a little bit of ingenuity and persistence on the part of the analyst.

If this vector file has been worked on in GRASS before, a file of registration points with this same file name will already have been created and be stored in the reg directory in the mapset of the user who created the file. If the user specifies the name of an existing file, the program automatically accesses the registration points that were used in the last digitizing session. The user may use these same registration points, add additional ones, or choose completely new points in the current session, as shown below. See Ruiz and Messersmith, 1990, for a more detailed discussion of registration points. (If this is a new file, the user will NOT see the following message.)

| Use set of registered points from last session (y/n)? |

Enter y to use the same registration points as in the previous session, or enter n to register the map using new points. The following screen appears:
MAP REGISTRATION POINTS

Enter 4 - 10 points : points registered 0

<table>
<thead>
<tr>
<th>Point #</th>
<th>X coord</th>
<th>Y coord</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>590000.00</td>
<td>4915000.00</td>
</tr>
<tr>
<td>2</td>
<td>590000.00</td>
<td>4927000.00</td>
</tr>
<tr>
<td>3</td>
<td>599000.00</td>
<td>4927000.00</td>
</tr>
<tr>
<td>4</td>
<td>599000.00</td>
<td>4915000.00</td>
</tr>
<tr>
<td>5</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>6</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>7</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>8</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>9</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>10</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Enter 0.0 to delete a coordinate set.
Those marked by ‘*’ are registered.

AFTER COMPLETING ALL ANSWERS, HIT <ESC> TO CONTINUE
(OR <Ctrl-C> TO CANCEL)

Reading from the map, type in the (x,y) coordinates for each registration point using the keyboard. Move through the list (alternate x,y pairs) by entering <RETURN>. Remember, in most cases X refers to [UTM] EASTINGS and Y to [UTM] NORTHINGS. v.digit requires that at least four points be registered; ten points are the most that may be entered. It is a good practice to enter as many registration points as possible since some points will probably have to be eliminated because of accuracy problems. These points are used to construct a surface grid system for the map. The points should be distributed throughout the map to avoid amplifying accuracy errors that can be caused by choosing points clustered closely together over a relatively small (and perhaps unrepresentative) section of the map area being registered.

Also, it is convenient to enter the coordinates in some order; again, each analyst will have his/her own style for executing these tasks. For example, begin by entering the coordinates of the registration point nearest the lower left (usually southwest) corner of the map, and continue entering points in a clockwise direction until all of the coordinates are entered. In this example, as is common practice, a USGS 7.5' quad sheet has been used to select the registration points. Only four registration points are used in this case. Note the progression in the direction of the UTM (x,y) coordinate pairs from the lower left to the lower right corner of the map.

Once the user has finished entering the coordinates of the registration points, and double-checked them for typing errors, press the <ESCAPE> key to continue. These first four points can be used to construct a map neatline. See section 13 (The Toolbox Menu) for a discussion of this feature. The next screen appears:
This screen displays options which deal with the registration points. Depending on the brand of digitizer used, the screen may look slightly different than shown above. The numbers in brackets at the bottom of the screen refer to numbered keys or buttons on the digitizer cursor.

To register a point, locate the button labeled "<0>" on the cursor. Sight the cross-hair of the cursor over the first point to be registered and press "<0>". As each point is registered, an asterisk (*) appears to the left of it. The program also emits an audible "BEEP" to let the user know the point has been collected. Once a point is registered, v.digit automatically proceeds to the next point. Enter "<1>" on the cursor to skip any point. If a mistake has occurred, you can press "<2>" to unregister inaccurate points so that they can be reregistered or removed from consideration altogether. If more registration points are needed, choose "<3>" and type in the coordinates of the additional points.

Once a minimum of four points is registered, a fourth column (RESIDUALS) appears on the right side of the screen listing the residual error associated with each point:
### POINTS TO REGISTER

<table>
<thead>
<tr>
<th>POINT</th>
<th>EASTING (X)</th>
<th>NORTHING (Y)</th>
<th>RESIDUALS</th>
</tr>
</thead>
<tbody>
<tr>
<td>* 1.</td>
<td>590000.00</td>
<td>4915000.00</td>
<td>1.79</td>
</tr>
<tr>
<td>* 2.</td>
<td>590000.00</td>
<td>4927000.00</td>
<td>1.79</td>
</tr>
<tr>
<td>* 3.</td>
<td>599000.00</td>
<td>4927000.00</td>
<td>1.79</td>
</tr>
<tr>
<td>* 4.</td>
<td>599000.00</td>
<td>4915000.00</td>
<td>1.79</td>
</tr>
</tbody>
</table>

Number of points: 4, Points registered: 4
Residual mean average: 1.794367

### USING DIGITIZER CURSOR FOR INPUT

Key<0> - register point  
Key<1> - skip point   
Key<2> - unregister point  
Key<3> - add more points  
Key<4> - accept residuals

The residual is a statistical measure that indicates the accuracy of each registration point in relation to the others. In this case, the units are expressed as the number of meters of deviation. The magnitude of the residual error is based on the original scale of the map being digitized. (Ruiz and Messersmith, 1990 gives a more detailed explanation.) For example, as a general rule of thumb, for a standard USGS 7.5' quad sheet (1:24000 scale), the overall residual normally should be less than 9 and ideally less than 3. (Ruiz and Messersmith, 1990 also gives other examples and a more extended discussion of residuals.) Each individual residual should fall within two integers of the other residuals listed. Residuals can often be lowered by re-registering points ("<0>"), by eliminating specific points ("<2>"), or by adding new points ("<3>"). Once the residuals appear satisfactory, choose "<4>" to continue. (As explained above, the selected points are saved in a file and can be used to re-register the map in a subsequent digitizing session.) The following screen appears:
This screen is used to verify that the map registration is correct. Check known points on the map with the digitizer and compare them with the coordinates at the bottom of this screen.

<table>
<thead>
<tr>
<th>CHECK MAP: Key '0' to preserve point; Any other Key to continue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coordinates: X - Current - Y X - Saved - Y</td>
</tr>
<tr>
<td>0 595281.67 492082.36 0.00 0.00</td>
</tr>
</tbody>
</table>

GRASS uses the registration points the user has input and accepted to construct an entire surface coordinate system for the user's map. (It "registers" the map's surface coordinates to the digitizing tablet's surface coordinates.) The user can test the accuracy of the geo-referencing based on these registration points by using the screen function shown directly above. The user points to sites with user-known geographic coordinates on the paper map, and notes the digitizer coordinates corresponding to these points listed in the "Current" column, above; the user-known map coordinates should approximate the computed coordinate values listed in the "Current" column. Note that as the digitizer cursor is moved the coordinates under the "Current" heading constantly change. Pressing "<0>" temporarily freezes the coordinates of that point until the key is pressed again. This option may also be useful when registering two maps to one another, such as a quad sheet and a photocopy without coordinates. The locations of identifiable features on the photocopy can be pinpointed on the quad sheet and subsequently used as registration points for the photocopy version. (Unfortunately, the coordinates will have to be written down since it is not possible to save them directly to a file.) Pressing any key other than "<0>" proceeds to the next command screen.

Using Digitizer Cursor for Input
Key '0' for YES : Key '1' for NO

If satisfied with the registration, enter 'y', else 'n'

This screen asks the user to verify that the registration is satisfactory and to respond by using one of the designated cursor keys. Pressing "<1>" sends the user back to the registration screen, and "<0>" accepts the points that were entered.

5.2. DEFINING THE WORKING WINDOW

At this point, the user has entered v.digit, registered the map, and is almost ready to begin digitizing. The "digitizing region" that was created earlier (defined by the default region coordinates or others typed in the dig file header entered by the user just after entering v.digit) is probably too large an area
in which to work comfortably. The user now defines a "working window" as a subset of the "digitizing region." This conforms to the area displayed on the graphic screen, and the parameters can be changed repeatedly throughout the v.digit session (e.g., using the Zoom or Window Menus). The working window does not affect any other GRASS program, nor is it saved after the user exits v.digit. It exists only to provide graphic reference and to display small areas in which the user is focusing work.

Understanding the differences between the "digitizing region," "working window," "default region," and "current region" is important. If necessary, review these concepts before continuing (see, for example, explanations accessed through the GRASS 4.0 g.help program).

Use the digitizer cursor to pick two points on the map diagonal from each other to define the "working window" slightly outside the perimeter of the map image. The next two command screens appear in succession. For example, choose the lower-left (southwest) and upper-right (northeast) corners of the area.

---

Identify corners of graphics window.
Locate digitizer cursor on one corner of desired window.
Then hit any digitizer <KEY>

---

When a KEY is depressed, the user hears a BEEP confirming the selection.

---

Now place digitizer cursor on diagonal corner of desired window.
Then hit any digitizer <KEY>

---

After choosing the second point, another BEEP is emitted, and the program enters into the v.digit menu.
6. THE MAIN MENU

After the "working window" is selected, the v.digit program enters the Main Menu. The Main Menu serves as the entry and exit menu for all functions pertaining to vector data entry and modification. The layout of the Main Menu screen appears below:

<table>
<thead>
<tr>
<th>GRASS-DIGIT Version 4.0</th>
<th>Main Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAP INFORMATION</td>
<td>AMOUNT DIGITIZED</td>
</tr>
<tr>
<td>Name: Test, v.digit manual</td>
<td># Lines: 0</td>
</tr>
<tr>
<td>Scale: 24000</td>
<td># Area edges: 0</td>
</tr>
<tr>
<td>Person: U.D. Grassuser</td>
<td># Sites: 0</td>
</tr>
<tr>
<td>Dig. Thresh: 0.0300 in.</td>
<td>Total points: 0</td>
</tr>
<tr>
<td>Map Thresh.: 18.290 meters</td>
<td></td>
</tr>
</tbody>
</table>

OPTIONS:

Digitizer: Enabled

Digitize Edit Label Customize Toolbox Window Help Zoom Quit *!* *

GLOBAL MENU: Press first letter of desired command. [Upper Case Only]

6.1. MAIN MENU OPTIONS

v.digit is composed of a hierarchy of menus, each of which is composed of a number of fields describing the menu functions and options. The top field, or the TITLE FIELD, displays the version of GRASS-DIGIT being used and the name of the currently selected menu.

The MAP INFORMATION field is extracted from the header information typed in by the user upon first entering the digitizing session. It provides a quick reference to the user and also provides the current status of the digitizing and map thresholds currently selected (see the Customize Menu for an explanation of what the thresholds mean). This field appears only on the Main Menu.

The AMOUNT DIGITIZED field shows the status of the amount of each type of feature (i.e., line, area, or site) that has been digitized and the total number of points comprising these features. This field appears only on the Main and Digitize menus.

The OPTIONS field lists the functions available to the user in any given menu. In the Main Menu, it shows the status of the digitizing device being used; here, it is the digitizer that is enabled. If no digitizer had been selected for use, this field would state: Digitizer: Disabled (see the Customize Menu options on how to toggle the digitizing device).

The GLOBAL MENU (bottom field) shows the other menus available to the user through the currently selected menu. Use the KEYBOARD to select an alternate menu by typing in the first letter (UPPER CASE). Global Menu options may be chosen only when they appear on the current menu page. Only one menu is available for use at any given time. Six options appearing in the Global Menu field at the bottom of the Main Menu refer to specific sub-menus: Digitize, Edit, Label, Customize, Toolbox, and Window.
There are six *Main Menu* global options that are not menu names:

**Zoom** allows the user to zoom or pan over the vector layer. Since this is a significant function, however, it is discussed in a separate section.

**Help** displays menu-specific interactive help to the user.

**Quit** exits the user from the current *v-digit* session and automatically saves any work completed during this time. This option is available only from the *Main Menu*.

The asterisk, "*", refreshes the *terminal* screen.

The exclamation sign (or bang), "!", refreshes the graphic screen. When executed, the following message appears in the global field:

```
Wait. Replotting the Screen.
. . . Press <ESC> key to stop redraw
```

The screen is erased, and any digitized lines will begin to be redrawn. Pressing the <ESCAPE> key stops the redraw at that point, and allows the user to use other options. This is especially useful for large files such as soils, contour lines, or others where it would be inconvenient to wait for the entire file to redisplay.

The carat, "^", is used to unlock the monitor when changing (back and front) between the digitizing (graphic) and (shell) windows on SUN workstations. If the monitor should lock up, pressing the carat several times should release it. This feature also works on X terminals.

**Help**, "*", "!", and "^", are available from any menu.

Before actually entering *D* to digitize, try moving through the other menus. Notice that the global options available within each submenu are slightly different than the ones available in the *Main Menu*. To reiterate, remember that typing the first letter of any of the available options causes the current option to be replaced with the new option. When comfortable with the menu and option structure, proceed to the next section.
7. THE DIGITIZE MENU

The Digitize Menu is where the actual input of vector data occurs. It is accessible from the Main, Edit, and Label menus. The following sections first describe the use of the digitizing cursor for data input, followed by use of the mouse (see also the Customize Menu in section 10). The screen layout of the Digitize Menu with the default parameters is shown below:

<table>
<thead>
<tr>
<th>GRASS-DIGIT Version 4.0</th>
<th>Digitize Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ACME digitizer</strong></td>
<td><strong>AMOUNT DIGITIZED</strong></td>
</tr>
<tr>
<td><strong>Cursor keys:</strong></td>
<td><strong># Lines:</strong> 0</td>
</tr>
<tr>
<td><strong>&lt;0&gt; digitize point</strong></td>
<td><strong># Area edges:</strong> 0</td>
</tr>
<tr>
<td><strong>&lt;1&gt; quit digitizing</strong></td>
<td><strong># Sites:</strong> 0</td>
</tr>
<tr>
<td><strong>&lt;2&gt; update monitor</strong></td>
<td><strong>Total points:</strong> 0</td>
</tr>
<tr>
<td><strong>&lt;3&gt; toggle point/stream mode</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Digitize options:**

- `<space>` Digitize
- `m` - Toggle MODE
- `t` - Toggle TYPE
- `l` - Auto Label
- `q` - Quit to main menu

**CURRENT DIGITIZER PARAMS.**

- **MODE**
- **TYPE**
- **point**
- **line**
- **>STREAM<**
- **>AREA EDGE<**
- **site**
- **AutoLabel:** DISABLED

**GLOBAL MENU:** Press first letter of desired command. [Upper Case Only]

---

7.1. DIGITIZE MENU FIELDS AND OPTIONS

The menu has four display fields, which provide the user reference information, function options, and interactive instructions. The UPPER LEFT field identifies whether the mouse or digitizer is selected, and if the latter, the brand of digitizer being used (here the fictitious "ACME digitizer"). It also describes the digitizer cursor functions. Each number within brackets refers to the corresponding key on the cursor:

**<0> Digitize Point**

Activates the digitizer for the collection of points.

**<1> Quit Digitizing**

Terminates the collection of points.

**<2> Update Monitor**

When digitizing in STREAM mode, points are continuously collected until the user quits digitizing or toggles to POINT mode, and the vector being digitized does not appear on the graphics display monitor until the user has quit digitizing. This key temporarily suspends the collection of points during digitizing and displays the line drawn on the graphics display monitor up to the point last digitized. (See the discussion of point and stream modes below and on the following page.)
<3> **Toggle Point/Stream Mode**

Allows the user to switch between POINT and STREAM modes without having to interrupt digitizing and switch to the keyboard. This function is useful for "on-the-fly" digitizing of more complex features having a combination of straight and curvilinear segments.

The UPER RIGHT field is entitled "AMOUNT DIGITIZED." It refers to the number of lines, areas, and sites digitized (see below), and the number of points used to represent these objects based on the digitizing thresholds specified (see the Customize/Display Menus described in sections 10 and 12). These numbers are continually updated to reflect changes in the features that have been digitized.

The LOWER RIGHT field entitled "CURRENT DIGITIZER PARAMS" displays the status of the digitizing parameters. Digitizing can occur either in POINT or STREAM mode (see below). Features are represented either as a LINE, AREA EDGE, or SITE (see below). The parameters currently set are CAPITALIZED and bracketed (> <). The default parameters, shown here, are "STREAM<" mode and "AREA<" type. The "AutoLabel:" parameter allows the user to specify a category value for features at the time they are being digitized (see below), thus eliminating the need to enter the Label Menu described in section 9.

The LOWER LEFT field entitled "DIGITIZE OPTIONS" contains the following functions:

<space> **Digitize**

Pressing the <SPACE BAR> on the keyboard activates the digitizer to start the collection of points.

m - **Toggle MODE**

Selects between the two modes of collecting points during digitizing: STREAM or POINT.

In POINT mode, the digitizer collects points only when the user pushes the <0> key on the cursor, that is, individually, one point at a time. Point mode is used for digitizing straight lines and simple features where the shape requires only a small number of points to accurately define it (i.e., straight roads or boundaries, section lines, site loci, etc.).

In STREAM mode, once the <0> key is depressed, the digitizer continually collects points as the cursor is moved. Stream mode is used when digitizing curves, complex lines, and other features where frequent collection of points is needed to capture detail (soil polygons, streams, etc.).

**t - Toggle TYPE**

Selects between the three types of features that can be digitized: LINE, AREA EDGE, or SITE. It is the decision of the analyst and his/her supervisor(s) to agree on the level of detail required to most accurately depict the feature in question.

A LINE is a two-dimensional feature that joins two points together. Features such as roads and streams are usually represented as lines.

An AREA EDGE is a line feature that defines a perimeter, border, or common boundary with other areas. Features like soil polygons are digitized as area edges.

A SITE is used to represent a point locus. Examples may include features such as archaeological sites, endangered species locations, artillery firing points, etc.

**l - Auto Label**

Toggles between the method of labeling to be used. The default is DISABLED (OFF) and the features must subsequently be labeled using the Label Menu (see section 9). When turned ON the user can specify the category value for line features while they are being digitized. The auto label method status (ON or OFF) is shown on the Main Digitize Menu under CURRENT DIGITIZER PARAMETERS.

q - **Quit to Main Menu**

Returns to the Main Menu.
7.2. THE DIGITIZING PROCEDURE

The digitizing procedure varies depending on the kind of feature being digitized. There are five possible combinations of digitizing parameters: POINT/SITE, POINT/LINE, POINT/AREA EDGE, STREAM/LINE, and STREAM/AREA EDGE. Logically, since a point represents only a singular locus, it would not be used with the STREAM mode. Along with the visual cues on the graphic screen, `v.digit` also warns the user with an audible BEEP when further action must be taken. Once the `<SPACE BAR>` on the keyboard is depressed, the `Global Menu` field shows how many points of a feature have been collected, and the UTM coordinates for each respective point. In STREAM mode these coordinates fly by relatively rapidly. In the following examples, brackets ([ ]) denote comments that do not appear on screen.

7.2.1. POINT MODE

In POINT mode, SITE type, data collection begins as soon as `<0>` is pressed. The sequence is:

| `<space bar>` | [activate digitizer] |
| `<0>`         | [digitize the site]  |
| `<1>`         | [end]                |
| [repeat next site] |                |
| `<1>`         | [exit]               |

The original `Digitize Menu` fields are replaced by the following fields:

<table>
<thead>
<tr>
<th>Site digitizing</th>
</tr>
</thead>
<tbody>
<tr>
<td># Points</td>
</tr>
<tr>
<td>0</td>
</tr>
</tbody>
</table>

POINT mode

When the `<0>` key is depressed, the Easting and Northing coordinates flash by very rapidly, and the following query appears:

```
USING DIGITIZER CURSOR FOR INPUT
Key '0' for YES : Key '1' for NO
NOTE: 1 new nodes needed
Do you accept this site?
```

The site location is first represented on the graphic screen by a yellow X, (i.e., "X" marks the spot). Check back and forth between the screen and the map to see if the location is correct. If so, press `<0>` again; the color of the site "X" changes from yellow to green, denoting that it has been accepted. Repeat the point input sequence above as needed. Press `<1>` to completely exit point-mode digitizing.

In POINT mode, in either the LINE or AREA EDGE types, the first time `<0>` is pressed activates the program to receive data. The second time `<0>` is pressed begins the collection of data points. That is, the sequence to collect points is:
As each line is digitized and closed, the segment between the beginning and ending nodes is highlighted in yellow. The following information appears where the Global Menu field was at the bottom of the Digitize Menu:

As each point is digitized, its sequence number (1,2,3, etc.) appears under the "Points" heading along with the UTM coordinates. After ending, the following query appears in the Global Menu field:

The number of nodes needed depends on how the line relates to surrounding lines -- if the line’s endpoints (i.e., nodes) connect (snap) to two already existing nodes, then it requires no additional nodes; if one of the line’s endpoints is snapped to an existing node but the other endpoint is not, the line requires one additional node; if both of the line’s endpoints are open and not snapped to existing nodes, then two new nodes are needed.

Check the map and graphics screen to ensure the line appears correct. When accepted, the line changes to the color corresponding to its topology (see the Customize/Color menu described in sections 10 and 11 for default colors). To exit completely from digitizing, press key <1> at the next prompt:
7.2.2. STREAM MODE

In STREAM mode, LINE or AREA EDGE type, data collection begins as soon as \(<0>\) is pressed. The sequence is:

| <space bar> | activate digitizer |
| <0> | start digitizing |
| <1> | end |
| [repeat next line/area] |
| <1> | exit |

**USING DIGITIZER CURSOR FOR INPUT**

Key ‘0’ for YES : Key ‘1’ for NO

Begin digitizing?

The line is not displayed on the graphic screen until digitizing is terminated, unless key \(<2>\) is used (see above). As each line is closed, the segment between the beginning and ending nodes is displayed in yellow. After ending, the following query appears in the *Global Menu* field:

**USING DIGITIZER CURSOR FOR INPUT**

Key ‘0’ for YES : Key ‘1’ for NO

NOTE: [0,1,2] new nodes needed

Do you accept this area line? [if an area edge] [or]

Do you accept this line? [if a line]

Check between the map and the graphic screen to make sure the line appears correct. When accepted, the line changes to the color corresponding to its topology (see the *Customize/Color Menus* shown in sections 10 and 11 for the default colors). If the line is not accepted, it is erased.

7.3. DIGITIZING WITH THE MOUSE

The mouse can also be used to perform digitizing. Normally, the mouse will be used primarily to add or delete lines (e.g., edit). It can, however, be used to digitize if a raster (cell) file is used as a data backdrop (see the *Customize Menu* overlay option). This can be accomplished in one of two ways: either by choosing to use no digitizer (“none”) when first entering the *v.digit* program (see section 5, *Entering v.digit*), or entering the *Customize Menu* and toggling the digitizing instrument from the digitizer to the mouse (see section 10). The first alternative is explained in more detail here. If the use of the mouse is selected, then this fact is displayed in the upper left field of the *Digitize Menu* screen (see below).
Use of the mouse follows the same general principles as using the digitizing cursor, and the same menu options apply. The major exception to this rule, however, is that the mouse can only be used to digitize in POINT mode; digitizing in STREAM mode is not allowed. Hence, as shown in the sample screen above, the Toggle MODE option in the Digitize Menu is blank, indicating that it is unavailable for use. The examples that follow use a three-button mouse.

When digitizing a SITE (using type: site), the following instructions appear:

As each site locus is selected by pressing the left button, a yellow "X" appears on the graphic screen, and the point’s Easting and Northing coordinates appear at the bottom of the screen. The following message appears:
Do you accept this site?

Buttons:
  Left: yes
  Middle: no
  Right: yes

<table>
<thead>
<tr>
<th># Points</th>
<th>Easting</th>
<th>Northing</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>490000.12</td>
<td>3440000.88</td>
</tr>
</tbody>
</table>

NOTE: 1 new nodes needed
POINT mode

Press the appropriate mouse button to respond.

To digitize an AREA or LINE, the following set of instructions appear:

Begin digitizing?

Buttons:
  Left: yes
  Middle: no
  Right: yes

And:

Point number 0

Buttons:
  Left: Mark a point
  Middle: (Back up one point)
  Right: Quit digitizing

<table>
<thead>
<tr>
<th># Points</th>
<th>Easting</th>
<th>Northing</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

POINT mode

As each point defining the line/area edge is selected, its sequence number and UTM coordinates are displayed; the line segment between the points is highlighted in yellow. The following screen shows that four points have been digitized to define a line, along with the UTM coordinates of the last point.
Point number 4

Buttons:
Left: Mark a point
Middle: (Back up one point)
Right: Quit digitizing

<table>
<thead>
<tr>
<th># Points</th>
<th>Easting</th>
<th>Northing</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>505400.12</td>
<td>3440686.88</td>
</tr>
</tbody>
</table>

POINT mode

If a point does not appear correct, use the middle key to delete it; press the middle key repeatedly to delete a number of successive points. Upon quitting, the next message appears:

Do you accept this line?

Buttons:
Left: yes
Middle: no
Right: yes

<table>
<thead>
<tr>
<th># Points</th>
<th>Easting</th>
<th>Northing</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>505400.12</td>
<td>3440686.88</td>
</tr>
</tbody>
</table>

NOTE: [0,1,2] new nodes needed

POINT mode

Press the appropriate mouse button; continue the digitizing procedure as needed. Practice digitizing with each of the possible cursor and mouse combinations to become familiar with the differences.
8. THE EDIT MENU

The Edit Menu is used to modify vector files that have been digitized or imported from other sources. It can be accessed from all the other submenus. The following screen shows the layout of the Edit Menu with the default parameters. In the options below, the word “line” is used generically and also refers to area edges.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>r</td>
<td>Remove line</td>
</tr>
<tr>
<td>i</td>
<td>Remove a site</td>
</tr>
<tr>
<td>s</td>
<td>Snap line to node</td>
</tr>
<tr>
<td>b</td>
<td>Break a line</td>
</tr>
<tr>
<td>m</td>
<td>Move a point</td>
</tr>
<tr>
<td>M</td>
<td>Move a line or site</td>
</tr>
<tr>
<td>t</td>
<td>Re-type a line (AREA/LINE)</td>
</tr>
<tr>
<td>d</td>
<td>Display nodes w/ in map threshold</td>
</tr>
<tr>
<td>R</td>
<td>Remove BLOCK of lines</td>
</tr>
<tr>
<td>q</td>
<td>Quit to main menu</td>
</tr>
</tbody>
</table>

8.1. EDIT MENU OPTIONS

Edit uses a combination of keyboard entries and cursor inputs to execute command functions. Type in the first letter of an option name to activate it. Interactive instructions appear on the dumb terminal screen (or the shell window if only a graphics monitor is used). The MOUSE is used in all editing operations. Most editing procedures follow a left-right-left-right button sequence for first choosing, and second, accepting, the editing function. The middle button is used to abort the current function. All colors described below are the DEFAULT colors for the particular function or feature (see the Customize/Color Menus). The features being edited are highlighted in yellow. The user should be very careful when using the "remove" functions within Edit; if accidentally removed, features may be hard to recover or reconstruct.

r - Remove Line

Removes a previously digitized line. Choose and accept the line; it disappears from view on the graphics screen. This option repeats automatically for as many features as the user requires.

i - Remove a Site

Removes a previously digitized site location. Choose and accept the site; it will disappear from view on the graphics screen. This option repeats automatically for as many features as the user requires.

s - Snap Line to Node

Manual procedure to "snap," or join, two separate nodes together to form one node. First choose a line and node to snap "from" and then a node to snap "to." This option will repeat automatically for as many features as the user requires. See the expanded explanation below.
b - Break a Line
Breaks an existing line segment into two new segments and inserts a node at the designated location. First choose a line to "break," and then a "point" on the line to break. A new snapped node will appear at the designated locus. This option repeats automatically for as many features as the user requires.

m - Move a Point
Used to reposition a point in a line. This option does not allow the movement of nodes at the end of line segments, only the points within a line. Choose a line and a point to move, and a new position for the point. The point moves to the new location and the shape of the line is adjusted accordingly. The user may wish to use option "n - Show Points in Lines" in the Window Menu before moving the point (see section 14).

M - Move a Line or Site
Used to reposition a line or site to a new location. Unlike "m" above, this option retains the orientation and shape of the original feature, but simply moves the whole feature to a new position. Choose a line/site to move, and a new location for the line/site. The line/site reappears at the new location.

d - Display Nodes w/in Map Threshold
Displays nodes that occur within the given distance threshold calculated for the current session. This is used to verify if nodes from different lines occur close enough to be snapped together, even though they should not be. This is important if nodes will be automatically snapped together during v.support. The user is allowed to make the map threshold larger but not smaller. Type the new threshold value after the prompt.

t - Re-type a Line (AREA/LINE)
Changes the type of a line between either an area edge or a line. Use the mouse to point at the feature to be changed. Choose and accept the line; the color of the feature changes, indicating that its topology has changed. This option repeats automatically for as many features as the user requires.

R - Remove BLOCK of Lines
Designates a group of lines to be removed, rather than having to delete them individually using the "r" option described above. Use the mouse to define a box around the area where a block of lines is to be deleted. Choose and accept the area. The program asks for confirmation before deleting the lines. Only the lines bounded within the box are removed. Exercise extreme caution when using this option.

q - Quit to main menu
Returns to the Main Menu.

8.2. THE EDITING PROCEDURE

One of the most frequently used procedures in the Edit Menu is that of snapping adjacent nodes together to join line segments. It is also the most complicated function, in that it involves more than one segment. The user should be wary when using this function because it can radically alter the shape of lines if the nodes to be snapped together are too far apart (refer to the Customize Menu in section 10 for a description of the "digitizing" and "snapping" thresholds). An expanded explanation of the procedure is presented here. It should provide an adequate model describing the other editing functions. Before entering the edit menu, the user can display the digitized data on the graphics monitor and search for possible digitizing errors.

After selecting "s - Snap Line to Node" the following sequence appears [a line "X" has been selected using the mouse pointer]:
Line to snap FROM:

Buttons:
Left: Choose line
Middle: Abort/Quit
Right: Accept chosen line

Line#: X Category: (unlabeled)

1) The selected line is highlighted in yellow and the next query appears [where node "Y" has been selected]:

Node to snap TO:

Buttons:
Left: Choose node
Middle: Abort/Quit
Right: Accept chosen node
	node#: Y

EAST: [UTM Easting]
NORTH: [UTM Northing]

2.) With the LEFT mouse button, select the node to which you want the line snapped.

3.) The selected node is highlighted in yellow; pressing the RIGHT mouse button accepts the node and causes the two adjacent nodes to be snapped. In the case of two "open" nodes (green), the two will be joined to form one "closed" node (red). Where a line is being snapped to an existing closed node, the sequence is FROM the line TO the node. It is not possible to snap existing closed nodes to each other. (See also the discussion of digitizing and snapping thresholds in the Customize Menu in section 10.1.) Also be aware of the following warning message (answering "no" repeats the above two steps):

Attempting to snap a line to itself. Proceed? [y]

Especially where two nodes are close together, the wrong line may be inadvertently chosen to "snap FROM"; if the node is snapped then the line may actually "double-back" on itself and the original topology may be destroyed, or a duplicate line or sliver may be created which can cause problems when the file is to be converted into a raster layer. If the user mistakenly destroys original topology, the user may have to redigitize the modified area. In the case of a self-closing polygon composed of one line with two open endpoints (nodes), this warning message can be ignored, because the polygon is being closed intentionally on itself.
9. THE LABEL MENU

Labeling is the process of assigning category values to digitized features. The Label Menu can be accessed from the Main, Digitize, and Edit Menus (described in sections 6, 7, and 8). The screen layout of the Label Menu\(^1\) with default option settings is presented below. Colors described for the options are the defaults (see the Customize/Color menus, described in sections 10 and 11), which the user may change.

<table>
<thead>
<tr>
<th>GRASS-DIGIT Version 4.0</th>
<th>Label Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label options:</td>
<td></td>
</tr>
<tr>
<td>a - Label Areas</td>
<td>m - Label Multiple Lines</td>
</tr>
<tr>
<td>l - Label Lines</td>
<td>M - Un-Label Multiple Lines</td>
</tr>
<tr>
<td>s - Label Sites</td>
<td></td>
</tr>
<tr>
<td>A - Un-Label Areas</td>
<td>c - Label Contours</td>
</tr>
<tr>
<td>L - Un-Label Lines</td>
<td>i - Contour interval: &lt; 5&gt;</td>
</tr>
<tr>
<td>S - Un-Label Sites</td>
<td></td>
</tr>
<tr>
<td>B - Bulk Label Remaining Lines</td>
<td></td>
</tr>
<tr>
<td>h - Highlight Lines of category #</td>
<td></td>
</tr>
<tr>
<td>d - Display Areas of category #</td>
<td></td>
</tr>
<tr>
<td>q - Return to main menu</td>
<td></td>
</tr>
</tbody>
</table>

GLOBAL MENU: Press first letter of desired command. [Upper Case Only]

9.1. LABEL MENU OPTIONS:

a - Label Areas
Assigns a category value to an area. (See the expanded explanation in section 9.2., Labeling Procedure.)

l - Label Lines
Assigns a category value to a line. First, type the category number after the prompt. Next, move the pointer to the line to be labeled (here, unlabeled lines are blue). Choose and accept the line. The line being labeled is highlighted in yellow, and when accepted turns magenta. No label value appears next to the line (enter the Customize/Display Menu to change the display option). Repeat labeling lines with the same category value as needed.

s - Label Sites
Assigns a category value to a site. First, type the category number after the prompt. Next, move the pointer to the site to be labeled (unlabeled sites are green). Choose the site with the left button and accept it with the right. The site being labeled is highlighted in yellow, and when

\(^1\) Although it is planned that future releases of GRASS issued by USACERL and the USDA SCS will be identical, these two releases may offer somewhat different functions in GRASS 4.0. The functions described in this tutorial are those of the USACERL GRASS 4.0 release, available to all GRASS users.
accepted turns aqua. No label value appears next to the site (see the Customize/Display Menu to change the display option). Repeat labeling sites with the same category value as needed.

A - Un-Label Areas

Removes a category value from an area or group of areas. Move the pointer inside the area to be unlabeled. Choose and accept a point within the area. Next, move the pointer to a boundary line for the area and choose and accept the line. The area marker and/or label inside the polygon disappears and the color of the selected area changes from orange to grey. Repeat as necessary.

L - Un-Label Lines

Removes a category value from a line or group of lines. Move the pointer to the line to be unlabeled. Choose and accept the line; the color changes from magenta to blue. Repeat as necessary.

S - Un-Label Sites

Removes a category value from a site or group of sites. Move the pointer to the site to be unlabeled. Choose and accept the site; the color for the site changes from aqua to green. Repeat as necessary.

B - Bulk Label Remaining Lines

Labels any lines which remain unlabeled (this option does NOT apply to area edge lines). Upon choosing this option, the user is asked to respond to the following prompt:

```
This function will label EVERY unlabeled line. Proceed [n]
```

If the answer is yes, enter the category number at the prompt. As the program proceeds to label, the color of the remaining lines changes from blue to magenta on the graphic screen. This option is convenient for labeling a large number of line features having the same category value, such as roads or streams. Be cautious when executing this option, however, to make sure that all lines have been labeled properly. This option does NOT apply to labeling area edge lines.

h - Highlight Lines of Category #

Type the category value after the prompt. The lines with the specified category value are highlighted in yellow.

d - Display Areas of Category #

Type the category value after the prompt. The areas with the specified category value are highlighted in yellow.

m - Label Multiple Lines

Labels line segments contiguous to each other (i.e., connected by "snapped" nodes). Type the category number after the prompt. Use the pointer to choose a line to label. The program highlights the connecting lines and asks the user if these are correct. Press the left or right button to answer yes. The highlighted lines will change color to magenta. This option is convenient for labeling a large number of contiguous line features of the same category, such as roads or streams (see also the "Autolabel" function). Be cautious when executing this option to make sure that all lines have been labeled properly. Lines that are not directly connected to each other (i.e., have "open" nodes between them) are not affected by this option, nor are area edge lines.

M - Un-Label Multiple Lines

Unlabels line segments contiguous to each other (i.e., connected by "snapped" nodes). Use the pointer to choose a line to unlabel. The program highlights any connecting lines and asks the user to confirm these lines. Press the left or right button to answer yes. All the lines will change color to blue. Be cautious when executing this option. The program does NOT differentiate between different category values for the contiguous lines. ALL lines will be unlabeled, whether
they have the same category labels or not. Lines that are not directly connected to each other (i.e., have "open" nodes between them) are not affected by this option, nor are area edge lines.

c - Label Contours
This option allows the rapid labeling of contour line data, such as that imported from DXF or DLG format files, rather than having to label each interval line individually. The user first selects a contour interval. (See option i following.) The user is instructed to choose and accept a starting line and an associated elevation value. Then select an ending line and associated elevation value. The elevation values and the interval must correspond exactly. For example, if there are five lines to be labeled, the contour interval is 5, and the first line has a value of 250, then the fifth line must have a value of 270. The program returns an error message if the contour interval and the starting/ending line elevation values do not match.

i - Contour Interval:  < 5>
Selects an interval to label contour lines (see the previous option, c). The interval can be any unit, e.g., 1, 2, 4, 5, 10, etc. The default setting is 5. The interval specified is completely arbitrary, or in the case of imported DXF or DLG files, recorded as a data attribute. The user should be aware of the original map data and how it was extracted.

q - Return to Main Menu
Return to the Main Menu (see section 6).

9.2. THE LABELING PROCEDURE
The Label Menu uses a combination of keyboard entries and cursor inputs to execute functions. Type the first letter of an option name to activate it. Interactive instructions appear on the dumb terminal screen (or the shell window if only a graphics monitor is used). The mouse is then used to select the feature to be modified. Labeling operations using the mouse follow a left-right-left-right button sequence for first choosing, and second, accepting, (i.e., verifying) the features. The middle button is used to quit the current function. The "label" and "unlabel" functions are somewhat redundant. For example, it is not necessary to "unlabel" a feature before giving it a new label; it is possible to relabel a feature directly by using the label option and simply assigning a new category value. The old label is overwritten by the new one.

Before beginning to label, identify each possible feature on the original map and the label value that will be assigned to it. Most analysts have their own mnemonic procedure for labeling. For features having no numerical values associated with them (such as soil types, streams, etc.) it is suggested to label the features sequentially, beginning with category value 1 and continuing as needed. For those features already possessing a known numerical value (such as a contour line, firing point, etc.) the analyst may want to retain the original designation.

IMPORTANT: Labels can only be positive or negative integers; no alpha characters or decimal points are acceptable. The value zero, 0, is reserved for the category no data. No feature may be labeled with a zero. Zero is also used to exit out of the labeling function (see below).

The labeling procedure is similar for areas, lines, and sites. Since the labeling of areas is the most complicated, however, it is described in more detail here. This should serve as an adequate model describing the other labeling functions.

After selecting "a - Label Area," the following sequence appears:
Enter Category Number (0 to END):[0]

Type in the category number for the area, and <RETURN>. The next message appears:

Select point within area:

Buttons:
  Left: Choose this position
  Middle: Abort/Quit
  Right: Accept chosen point position

Point location:
  East: [UTM Easting]
  North: [UTM Northing]

On the graphic screen, position the pointer within the chosen area, usually somewhere near the middle of the feature, and press the LEFT button. A yellow dot appears at the designated locus, and the UTM coordinates of the point are displayed on the menu screen. If this position is not suitable, simply move the pointer and choose a new spot. Once the position is satisfactory, press the RIGHT button to accept it; the color of the dot changes to orange (this is the AREA MARKER). The next message appears:

Select a Boundary line:

Buttons:
  Left: Choose line
  Middle: Abort/Quit
  Right: Accept chosen line

Position the pointer on a boundary line defining the area and press the LEFT button; the chosen line is highlighted in yellow. The following message appears on the bottom of the menu screen:

Area is not labeled

[OR] if the area has been previously labeled:

Area is labeled category X
[Where "X" is some integer]
If the highlighted line is correct, then accept it with the RIGHT button. All the other lines defining the selected area are highlighted in yellow. Some problems can occur at this stage of the process--if there are any open nodes around the perimeter of the area, or slivers or overshoots, the program responds with a BEEP and the following warning message appears:

```
Could not create area
```

This message disappears quickly, and the program reverts to the point selection screen. The analyst has to determine the cause of the error message and may have to perform additional editing and/or digitizing. The Toolbox, Window, and Debug Menus can also be consulted for further assistance (see sections 13, 14, and 16). Provided no errors occur, however, the next message appears:

```
Accept this area?

Buttons:
  Left: yes
  Middle: no
  Right: yes

Area is Category X
```

If the area appears satisfactory, press either the LEFT or RIGHT button; the color of the boundary line changes to orange and the category label appears to the upper right of the area marker. After accepting the area, the program returns to the point selection screen. If continuing to label other areas with the same category label, simply repeat the process. To change category values, press the MIDDLE button to quit, type in the new number, and proceed. To end the labeling process altogether, type in zero [0] and <RETURN> at this juncture. In the display default settings, note that if the graphic screen is redisplayed or the Customize/Display Menu options are modified, then the category labels disappear, leaving only the area markers, and the area edges turn color back to grey.
10. THE CUSTOMIZE MENU

This menu contains options to modify certain input and display parameters during a digitizing session. The screen layout of the Customize Menu and the default settings are presented below. This menu can be accessed from the Main, Digitize, Edit and Label Menus.

<table>
<thead>
<tr>
<th>GRASS-DIGIT Version 4.0</th>
<th>Customize Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customize options:</td>
<td>Current:</td>
</tr>
<tr>
<td>d - Set digitizing threshold</td>
<td>0.0300</td>
</tr>
<tr>
<td>s - Set snapping threshold</td>
<td>0.0300</td>
</tr>
<tr>
<td>b - Toggle BEEP</td>
<td>ON</td>
</tr>
<tr>
<td>a - Toggle Auto Window</td>
<td>OFF</td>
</tr>
<tr>
<td>w - Toggle Windowing device</td>
<td>DIGITIZER</td>
</tr>
<tr>
<td>p - Toggle Point device</td>
<td>MOUSE</td>
</tr>
<tr>
<td>d - Toggle Digitizing device</td>
<td>DIGITIZER</td>
</tr>
<tr>
<td>O - Select An Overlay Map</td>
<td>None</td>
</tr>
<tr>
<td>B - Select a Backdrop CELL Map</td>
<td>None</td>
</tr>
<tr>
<td>- Select a Label Map</td>
<td></td>
</tr>
<tr>
<td>D - Enter Display Options Menu</td>
<td></td>
</tr>
<tr>
<td>C - Enter Color Options Menu</td>
<td></td>
</tr>
<tr>
<td>q - Return from whence we came</td>
<td></td>
</tr>
</tbody>
</table>

Help Zoom * ! ^

GLOBAL MENU: Press first letter of desired command. [Upper Case Only]

10.1. CUSTOMIZE MENU OPTIONS

All options in the Customize Menu are selected from the KEYBOARD by pressing the key corresponding to the first letter of the command. The Customize Menu options set within a digitizing session do not carry over into the next session. In the descriptions below, the DEFAULT settings are presented first, followed by the alternate.

d - Set Digitizing Threshold

Sets the amount of space to be left between points collected by the digitizer. To change the digitizing threshold, press "d" and the following message appears in the global field. Enter the new threshold value at the prompt. Upon exiting, the new value appears under the "Current" heading. (Ruiz and Messersmith, 1990 gives a more detailed discussion.)

```
Current thresholds:
    Map : 38.100000 meters.
    Dig : 0.030000 - 1 / 33,333333 of an inch.

Enter new Dig threshold or <RETURN> when finished:
```

s - Set Snapping Threshold

Sets a threshold value defining the amount of space less than which two adjacent nodes automatically are "snapped," or joined together, to make one node. For example, if the snapping threshold were set at 0.03 (digitizer) in., nodes placed less than 0.03 in. apart (on the digitizing tablet) would be snapped together into a single node, while nodes placed more than 0.03 in. apart would be left alone. The digitizing threshold and the snapping threshold do not necessarily have to be
the same for any particular scale map, but the default values usually are set the same. The threshold values chosen depend on the accuracy, resolution, and level of detail desired in the final digital map (Ruiz and Messersmith, 1990 gives a more detailed discussion). The format for choosing a new snapping threshold follows that of the digitizing threshold described above.

b - Toggle BEEP
Selects whether an audio signal is to be emitted from the terminal during the digitizing session. Many functions in \texttt{v-digit} use a \texttt{BEEP} to indicate their activation. It is recommended to keep the beep "ON" to determine when certain cursor functions have been selected, e.g., snapping nodes, editing, etc.

a - Toggle Auto Window
Adjusts the working window to automatically encompass more of an area feature being labeled if most of the area initially falls outside the original dimensions of the window. This option is used for labeling areas only (see also section 9, \texttt{Label Menu}).

w - Toggle Windowing Device
Selects whether the \texttt{DIGITIZER} cursor or the \texttt{MOUSE} is used as the windowing device. Once the working window has been initially selected using the digitizing cursor (see \texttt{Entering the Digitizing Session}), it may be more convenient to use the mouse to choose subsequent windows (see the \texttt{Zoom Menu}). If no digitizer is selected when entering the session, then only the mouse is available for use.

p - Toggle Point Device
Selects whether the \texttt{MOUSE} or the \texttt{DIGITIZER} cursor is used as the pointing device. In most instances, it is more convenient to use the mouse. If no digitizer is selected when entering the session, then only the mouse is available for use in this option.

d - Toggle Digitizing Device
Selects whether the \texttt{DIGITIZER} cursor or the \texttt{MOUSE} is used as the digitizing device. The digitizer cursor is normally used for the initial input of vector data. However, for modifying the data once they have been entered, it may be more convenient to use the mouse. If no digitizer is selected when entering the session, then only the mouse is available for use in this option.

O - Select an Overlay Map
Displays a background vector layer for visual comparison and reference. To display a vector overlay, type "O"; the following prompt appears at the bottom of the menu screen:

```
Enter the name of an existing vector file
Enter 'list' for a list of existing vector files
Hit RETURN to cancel request
>  
```

After choosing the vector file, the following query appears:

```
Do you want to automatically redraw backdrop on re-window? (y/n) [y]
```

After responding, this message appears in the global field:

```
Plotting overlay Map . . . Press <ESC> key to stop
```
More than one overlay vector layer can be displayed (although the result might be confusing). If the automatic redraw option is not selected and the working window is changed, all the overlay vectors will have to be reselected. The order in which vector overlays are selected is important. The second vector overlay supersedes the first. Only one overlay vector can be automatically redrawn. If the working window is changed, the last vector overlay selected for automatic redraw is the only one that will be redisplayed in the new window.

B - Select a Backdrop CELL Map

Displays a background raster (cell) layer under the current vector file. The background map is often useful for providing a frame of reference while digitizing and to check how the layers match each other. Only one backdrop raster map can be displayed at a time. The sequence for choosing the raster map is the same as for choosing the vector overlay map previously described. One note of caution: the color table for the raster layer may obscure the vector overlay map if the overlay color is not changed (see section 11, Color Menu, to change the default color options).

L - Select a Label Map

This option is not available at this time, but may be included in future GRASS releases.

D - Enter Display Options Menu

Accesses the Display Menu to change the display parameters of features appearing on the graphic screen (entry is possible only through this menu).

C - Enter Color Options Menu

Accesses the Color Menu to change the color parameters of features appearing on the graphic screen (entry is possible only through this menu).

q - Return from whence we came

Returns to the previous menu.
11. THE COLOR MENU

Features in v.digit are color coded for ease of identification. The screen layout of the Color Menu is presented below. The colors are the default settings of the features as they appear on the graphic screen. The Color Menu can only be accessed through the Customize Menu (see section 10).

<table>
<thead>
<tr>
<th>GRASS-DIGIT Version 4.0</th>
<th>Color Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color options:</strong></td>
<td><strong>Current:</strong></td>
</tr>
<tr>
<td>a - Areas</td>
<td>grey</td>
</tr>
<tr>
<td>l - Lines</td>
<td>blue</td>
</tr>
<tr>
<td>s - Sites</td>
<td>green</td>
</tr>
<tr>
<td>A - Labeled areas</td>
<td>orange</td>
</tr>
<tr>
<td>L - Labeled lines</td>
<td>magenta</td>
</tr>
<tr>
<td>S - Labeled sites</td>
<td>aqua</td>
</tr>
<tr>
<td>1 - Nodes w/ 1 line</td>
<td>green</td>
</tr>
<tr>
<td>2 - Nodes w/ 2 or more lines</td>
<td>red</td>
</tr>
<tr>
<td>h - Highlight</td>
<td>yellow</td>
</tr>
<tr>
<td>B - Background</td>
<td>black</td>
</tr>
<tr>
<td>O - Overlay map</td>
<td>white</td>
</tr>
<tr>
<td>r - Reset Defaults</td>
<td></td>
</tr>
<tr>
<td>q - Return from whence we came</td>
<td></td>
</tr>
</tbody>
</table>

Help Zoom *!^ |

GLOBAL MENU: Press first letter of desired command. [Upper Case Only]

------

11.1. COLOR MENU OPTIONS

Colors are changed by toggling the appropriate key for the feature to be changed (e.g., press a to change the color for areas). There are twelve colors that can be selected; they toggle in the following sequence: grey, magenta, aqua, indigo, violet, white, black, yellow, blue, red, green, orange. The first six options a through S are self-explanatory. The remaining options are described below. Once new options are selected, the graphic screen automatically refreshes to show the changes.

1 - Nodes w/ 1 Line

Nodes that form the endpoints of unattached line segments are open or "unsnapped" (here "line" is used in the generic sense, including also area edge lines). They are color-coded green.

2 - Nodes w/ 2 or more lines

Nodes at the intersection of two or more line segments (including area edge lines) should be closed or "snapped." They are color-coded red.

v.digit distinguishes between nodes which represent "open" and "closed" lines. The distinction between "open" and "closed" nodes is important if the vector layer represents area features to be converted into a raster layer. The creation of a raster area polygon is not allowed if the lines comprising the polygon are not properly connected, or closed. The creation of raster layers from sites or line segments is not affected by the presence of open nodes.

h - Highlight

Many functions in v.digit make use of highlighting. The default highlight color is yellow.
B - Background
Changes the background color field on which the vector lines are displayed. The default color is black.

O - Overlay Map
Selects the color of any vector files to be displayed as overlay references to the layer currently being digitized. See also the Customize Menu described in section 10.

r - Reset Defaults
Resets the default colors back to their original values if changed by the user during a digitizing session. Upon exiting a session, the color options are automatically reset to the default values. Any alternate color options must be specified again by the user on reentering the digitizing session.

q - Return from whence we came
Returns to the Customize Menu.
12. THE DISPLAY MENU

This menu contains options to change the display parameters for features appearing on the graphics screen during the digitizing session. The screen layout of the Display Menu showing default parameters is presented below. This menu can only be accessed through the Customize Menu described in section 10.

<table>
<thead>
<tr>
<th>GRASS-DIGIT Version 4.0</th>
<th>Display Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display options:</strong></td>
<td><strong>Current:</strong></td>
</tr>
<tr>
<td>a - Area Labels</td>
<td>OFF</td>
</tr>
<tr>
<td>l - Line Labels</td>
<td>OFF</td>
</tr>
<tr>
<td>s - Site Labels</td>
<td>OFF</td>
</tr>
<tr>
<td>m - Area Markers</td>
<td>ON</td>
</tr>
<tr>
<td>A - Area Border lines</td>
<td>OFF</td>
</tr>
<tr>
<td>L - Labeled lines</td>
<td>ON</td>
</tr>
<tr>
<td>i - Lines</td>
<td>ON</td>
</tr>
<tr>
<td>S - Sites</td>
<td>ON</td>
</tr>
<tr>
<td>n - Nodes</td>
<td>ON</td>
</tr>
<tr>
<td>p - Points in lines</td>
<td>OFF</td>
</tr>
<tr>
<td>r - Reset Defaults</td>
<td></td>
</tr>
<tr>
<td>q - Return from whence we came</td>
<td></td>
</tr>
<tr>
<td>Help Zoom * ! ^</td>
<td></td>
</tr>
</tbody>
</table>

| GLOBAL MENU: Press first letter of desired command. [Upper Case Only] |

12.1. DISPLAY MENU OPTIONS

Display options can be toggled between ON (they appear on the graphics screen) and OFF (they do not appear). Options set during a digitizing session do not carry over to the next; they are automatically reset to the default values. Refer to the Color Menu described in section 11 for the color coding of the Display Menu options. Colors mentioned below are the default colors. In the following descriptions, the default setting is described first, followed by the alternate.

**a - Area Labels**

This option is normally OFF to prevent cluttering of the screen when many features are being displayed. When turned ON, the category values assigned to labeled areas are displayed within the polygons (see the Label Menu in section 9). The latter setting is recommended when digitizing, labeling, and/or editing areas.

**l - Line Labels**

This option is normally OFF to prevent cluttering of the screen when many features are being displayed. When turned ON, the category values assigned to labeled lines are displayed near the midpoint of the lines (see the Label Menu in section 9). The latter setting is recommended when digitizing, labeling, and/or editing lines.

**s - Site Labels**

This option is normally OFF to prevent cluttering of the screen when many features are being displayed. When turned ON, the category values assigned to labeled sites are displayed to the upper right of the sites (see the Label Menu in section 9). The latter setting is recommended
when digitizing, labeling, and/or editing sites.

m - Area Markers
Displays the area marker of a labeled area, as represented by a point (default color orange). The marker is the actual point location in (x,y) space within the polygon where a category label has been placed (see the Label Menu in section 9). This point is used here only as a visual reference, but does have meaning with regard to feature topology (i.e., raster areas cannot be created without it). The user may wish to toggle the display of Area Markers OFF if the user is adding feature labels to a map, to prevent the display screen from becoming confusingly cluttered.

A - Area Border Lines
In the OFF setting, area edges are displayed in grey, whether the areas are labeled or not. If turned ON, the lines that make up labeled areas are displayed in orange. It is recommended to use the latter setting when digitizing, labeling, and editing areas.

L - Labeled Lines
Displays labeled lines in magenta and unlabeled lines in blue. If turned OFF, all lines will display in blue (not recommended). Area edge lines are unaffected; they remain white in color.

i - Lines
Displays unlabeled lines in blue, labeled lines in magenta, and area edges in grey. If turned OFF, only labeled lines appear (magenta) and lines defining area edges and unlabeled lines do not appear at all (not recommended).

S - Sites
Displays labeled sites in aqua, and unlabeled sites in green. If turned OFF, sites will be represented simply by a red (closed) node. The latter option is NOT recommended in order to avoid confusion with nodes on line segments and spurious "floating" nodes.

n - Nodes
Displays nodes as points. "Open" or "unsnapped" nodes are displayed in green, while "closed" or "snapped" nodes are displayed in red. If turned OFF, nodes will not appear (not recommended).

p - Points in Lines
This option is normally OFF to avoid possible confusion with nodes. If turned ON, all the points that describe a line are displayed, not just the nodes. The points are displayed the same color as the nodes they might represent, that is, red for a "snapped" or "closed" line segment, and green for "unsnapped" or "open" lines. If a line is composed of a mixture of snapped and unsnapped segments, then they are visually represented as unsnapped (i.e., the points will appear green). The ON setting is sometimes useful when breaking or snapping lines during editing (see the Edit Menu, described in section 8).

r - Reset Defaults
Resets all options to the default values.

q - Return from whence we came
Returns to the Customize Menu and refreshes the display screen if any parameters have been changed.
13. THE TOOLBOX MENU

This menu provides a number of utilities that help to find and diagnose problems that can occur while digitizing. In the following descriptions, the default highlight color for all options is yellow. The Toolbox Menu can be accessed from the Main, Digitize, Edit, and Label Menus.

<table>
<thead>
<tr>
<th>Tool box options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>w - Write out session</td>
</tr>
<tr>
<td>R - Register map</td>
</tr>
<tr>
<td>B - Build Neat Line</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GRASS-DIGIT Version 4.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbox Menu</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Toolbox options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>u - Display Unlabeled Areas</td>
</tr>
<tr>
<td>o - Display Open area lines</td>
</tr>
<tr>
<td>d - Display Duplicate lines</td>
</tr>
<tr>
<td>n - Display Node lines</td>
</tr>
<tr>
<td>i - Display Islands</td>
</tr>
<tr>
<td>q - return from whence we came</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Window Help Zoom * ! ^</th>
</tr>
</thead>
<tbody>
<tr>
<td>GLOBAL MENU: Press first letter of desired command. [Upper Case Only]</td>
</tr>
</tbody>
</table>

13.1. TOOLBOX MENU OPTIONS

w - Write out session

Saves the results of work completed during the current digitizing session. If the session lasts for a long time, this option should be used periodically to prevent loss of data due to an inadvertent power loss, system shutdown, or other interruption.

R - Register map

Allows the user to register and re-register one or more maps to the digitizing board without having to exit and re-enter v.digit. This is useful if the digitized map layer is composed of multiple map sheets (e.g., adjacent USGS quad sheets) as is often the case with large installations or geographic areas. The procedure is the same as when first registering a map (see Entering v.digit). If no digitizer is selected upon first entering the v.digit program, this option will not be available to the user. (It will show up as a "blank" space before the option description.)

B - Build Neat Line

When the points used to register a map form a rectangle (such as using four UTM grid intersections), this option can be used to form lines connecting these four points. The lines create a box, or "neat line" around the area defined by these lines and acts as a straight boundary that other lines can join. It also serves a visual purpose to highlight or emphasize a particular area of interest. If no digitizer is selected upon first entering the v.digit program, this option will not be available to the user. (It will show up as a "blank" space before the option description.)

u - Display Unlabeled Areas
Highlights, in yellow, those polygons that have not been labeled. The option works properly only after running the GRASS programs v.support or v.import. This is because the v.digit program cannot recognize the polygons until their spatial topology is built by v.support. For complex features, it may be helpful to first use the "Clear Window" function in the Window Menu (see section 14) before choosing this option.

o - Display Open Area Lines

Finds areas that cannot be properly labeled because there are one or more unsnapped nodes that prevent the polygons from closing. Edge lines that bound unlabeled areas are highlighted in yellow. It is recommended that this function be used only after labeling all areas and executing the GRASS program v.support.

d - Display Duplicate Lines

Highlights lines which have been accidentally double-digitized. See also "n - Display Node Lines" below.

n - Display Node Lines

Highlights the lines attached to a particular node. This function is useful for fixing two common digitizing problems: overshots and double-digitizing the same line. Areas are built in v.digit by following the angles of lines that attach to nodes; therefore, overshots cause bad angle information to be stored. This and double digitization can also cause slivers of bad data to be created (see Finding Errant Nodes below).

i - Display Islands

Highlights islands, or area polygons completely embedded or enclosed within other polygons. This option is useful for locating lakes, soil types, and other features that may occur within other features.

q - Return from Whence We Came

Returns to the menu used prior to the Toolbox Menu.

13.2. Finding Errant Nodes

It is sometimes difficult to locate a problem node when the program complains that it cannot label or build an area. Often the user has to examine each node intersection that composes an area polygon. At this juncture, it may be useful to enter the Debug Menu (see section 16, and below) to locate the nodes in question. It is suggested to zoom as closely as possible around the suspected node(s) since some slivers and line overshots can be quite small (see the Zoom Menu, described in section 15). At this time, it is also recommended to enter the Window Menu (see section 14) and choose the "C - Clear Window" option to erase the graphics screen. Then choose option "n - Show Nodes" to redisplay the suspected nodes (see section 14, The Window Menu). Sometimes at this point, "open" nodes that were previously obscured by other nodes may become apparent. These errant nodes may be the cause of the problem and can either be removed or snapped using the Edit Menu (see section 8). Then reenter the Toolbox Menu and choose option "n - Display Node Lines." The mouse is used to select and accept the node. Press the RIGHT mouse button to view lines counter-clockwise around the node, and the LEFT button to view them clockwise. Each line is highlighted sequentially around the node while a description of its topology is displayed at the bottom of the screen. Overshots are indicated when the visible lines extending from a given node fail to be highlighted in the proper sequence around the node. Double-digitized lines are indicated if a line is highlighted twice in a row. For a more detailed description of this process, consult the Debug Menu (see section 16).
14. THE WINDOW MENU

This menu provides options to modify the graphic screen parameters to check the accuracy and completeness of digitized features. This menu can be accessed through the **Main**, **Digitize**, **Edit**, **Label**, and **Toolbox Menus**. The screen layout of the **Window Menu** is presented below.

<table>
<thead>
<tr>
<th>GRASS-DIGIT Version 4.0</th>
<th>Window Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window options:</td>
<td></td>
</tr>
<tr>
<td>a - Show area markers</td>
<td>W - Define new window</td>
</tr>
<tr>
<td>A - Show area labels</td>
<td>C - Clear window</td>
</tr>
<tr>
<td>i - Show lines</td>
<td>c - Display scale</td>
</tr>
<tr>
<td>l - Show labeled lines</td>
<td>w - Where am I</td>
</tr>
<tr>
<td>L - Show line labels</td>
<td>O - Display Overlay Map</td>
</tr>
<tr>
<td>s - Show sites</td>
<td>B - Display Backdrop CELL Map</td>
</tr>
<tr>
<td>S - Show site labels</td>
<td></td>
</tr>
<tr>
<td>n - Show nodes</td>
<td></td>
</tr>
<tr>
<td>q - Return from whence we came</td>
<td></td>
</tr>
</tbody>
</table>

Help: Zoom * ! ^

**GLOBAL MENU**: Press first letter of desired command. [Upper Case Only]

14.1. WINDOW MENU OPTIONS

Many of the options in the **Window Menu** are redundant with those in the **Label** or **Toolbox** menus. However, the **Window Menu** is more often used for quick reference than for the actual modification of features. The options "a - Show Area Markers" through "S - Show Site Labels" should be familiar to the user from their use in other menus. The following options require some further explanation, however. All colors described below are the DEFAULT colors for the particular function or feature. See the **Customize** menu to change the default color and display options.

**n - Show Nodes**

Displays the nodes (line endpoints), whether closed (red) or open (green). This option is useful for locating problem nodes when trying to label or create area polygons (see also the **Label**, **Toolbox**, and **Debug Menus**).

**W - Define New Window**

Starts an interactive procedure to define a new digitizing window. The options are to zoom in/zoom out or pan (same as the **Zoom Menu**). Use either the mouse or the digitizer cursor to define a window.

**c - Display Scale**

Displays a bar scale in the upper-left corner of the current digitizing window. The scale is metric (kilometers or meters, depending on the size of the window).

**C - Clear Window**

Erases the contents of the graphics window on the monitor screen. Use this option before displaying the features to be examined (see options "a" through "n" above). This option is useful
for locating "unsnapped" nodes, errant lines, unlabeled areas, etc. (also see the Toolbox Menu).

w - Where Am I
Activates the pointing device for use as a location finder. The (x,y) coordinates are displayed in the global menu field.

O - Display Overlay Map
Changes the background vector layer to use as reference. This option is available only if the user has first selected a vector overlay layer using the Customize/Display Menu.

B - Display Background CELL Map
Changes the background raster layer to use as reference. This option is available only if the user has first selected a background raster layer using the Customize/Display Menu.

q - Return from Whence We Came
Returns the user to the previous menu.
15. THE ZOOM MENU

This option provides a number of utilities that allow the user to move through the vector file and to zoom or pan around designated features within it. The Zoom Menu can be accessed from all the other menus. The following sequence describes: first, how to use the windowing mode; second, the Zoom mode; and third, the Pan mode. In the examples below, the mouse is used as the windowing device (see the Customize Menu).

Upon entering Zoom the following screen appears:

<table>
<thead>
<tr>
<th>Buttons:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left: Select new window</td>
</tr>
<tr>
<td>Middle: Abort/Quit</td>
</tr>
<tr>
<td>Right: Zoom/Pan MENU</td>
</tr>
</tbody>
</table>

Selecting the LEFT button activates the mouse for use as a WINDOWING device.

<table>
<thead>
<tr>
<th>Buttons:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left: Establish a corner</td>
</tr>
<tr>
<td>Middle: Widen view</td>
</tr>
<tr>
<td>Right: Accept window</td>
</tr>
</tbody>
</table>

A "rubber-band" box appears in the current working window with the pointer as its nexus. To examine an area within the current working window, use the LEFT button to choose a starting corner, and drag the pointer to an opposite corner to form a box around the designated area or feature. Choose the RIGHT button to accept the new window. The graphic screen refreshes, and the new area is displayed. If the user wishes to examine an area outside of the current working window, then use the MIDDLE button to widen the view. When this option is chosen, the graphic screen is refreshed, and the user sees a rectangular blue field representing the Default Region created for the current data layer. The last working window examined is displayed as a red box within the blue field. Surrounding the blue field is a black field representing the area outside the Default Region. Again, use the left button to put a box around the desired area and press the right button to accept it. If a working window totally or partially outside of the Default Region is selected, the following warning message appears:

| Window is outside of default. Proceed? [y] |

After choosing the new window the following screen again appears:

<table>
<thead>
<tr>
<th>Buttons:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left: Select new window</td>
</tr>
<tr>
<td>Middle: Abort/Quit</td>
</tr>
<tr>
<td>Right: Zoom/Pan MENU</td>
</tr>
</tbody>
</table>

Pressing the RIGHT button enters the Zoom/Pan mode.

<table>
<thead>
<tr>
<th>Buttons:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left: Zoom MENU</td>
</tr>
<tr>
<td>Middle: Abort/Quit</td>
</tr>
<tr>
<td>Right: Pan MENU</td>
</tr>
</tbody>
</table>

To ZOOM press the LEFT button.
The ZOOM mode can be used to move as far away from, or in as close to, a feature as required. Every time a button is depressed, the graphic screen is redisplayed with the newly selected area. In ZOOM, the center point of the current window frame is used as the reference point to zoom around. This point cannot be changed in the ZOOM mode. It can, however, be changed in the PAN mode, which is examined next. To exit the ZOOM mode, press the MIDDLE button. The following screen again appears:

Press the RIGHT button to enter the PAN mode. Movement across the data layer is determined by the position of the mouse pointer, and at first may seem somewhat counterintuitive. The next screen illustrates the selection:

The LEFT button controls movement over the data layer. Placing the pointer to the LEFT side of the window appears to move features to the RIGHT and vice-versa. Likewise, moving the pointer to the BOTTOM of the window appears to move features UP in the window, and so on. The frame of reference is always toward the CENTER of the current window. Pressing the RIGHT button allows the user to focus on a specific feature and make it the center of reference.

To exit out of the Zoom/Pan Menu, continue to hit the MIDDLE button until the starting menu is accessed.
16. THE DEBUG MENU

The *Debug Menu* was originally designed for locating and fixing errors in *v.digit* during the program’s development. It is available in an incomplete and unsupported form, but is useful for finding information on features by referencing their internal topological structure. Within the *Debug Menu*, the word *line* is used generically. That is, all features originally are entered as vector data whether sites (technically, a line defined by one point), simple lines, or lines defining area perimeters. It can be accessed from any other *v.digit* menu by pressing the minus or dash, “-”, key. The screen layout for the *Debug Menu* is presented below:

```
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
<table>
<thead>
<tr>
<th>GRASS-DIGIT Version 4.0</th>
<th>Debug Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Debug options:</strong></td>
<td></td>
</tr>
<tr>
<td>l - Display line info</td>
<td></td>
</tr>
<tr>
<td>n - Display node info</td>
<td></td>
</tr>
<tr>
<td>a - Display area info</td>
<td></td>
</tr>
<tr>
<td>L - Find line</td>
<td></td>
</tr>
<tr>
<td>N - Find node</td>
<td></td>
</tr>
<tr>
<td>A - Find area</td>
<td></td>
</tr>
<tr>
<td>I - Find isle</td>
<td></td>
</tr>
<tr>
<td>d - Display Node-lines</td>
<td></td>
</tr>
<tr>
<td>q - Quit to main menu</td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td><strong>Zoom</strong></td>
</tr>
<tr>
<td>* ^</td>
<td></td>
</tr>
<tr>
<td><strong>GLOBAL MENU:</strong> Press first letter of desired command. [Upper Case Only]</td>
<td></td>
</tr>
</tbody>
</table>
```

16.1. DEBUG MENU OPTIONS

After digitizing or importing a vector file, executing the programs *v.support* and *v.import* may occasionally give a warning message about finding duplicate labels for a given line or area. This error can be caused by two things: either there are in fact duplicate labels in the file, or a label from a nearby area or line has been wrongly interpreted as belonging to the feature. The first error is only problematic if the label categories for the feature are not the same. In this case, the analyst must decide which of the multiple labels is correct and remove the other(s). In the latter case, the solution may be as simple as moving the label marker position using the *Label Menu*. These warning messages supply the problem feature’s internal reference number; using this information the features can be investigated using *Debug*.

*Debug* is divided into two sets of either mouse inputs or keyboard entries. Type in the first letter of an option name to activate it. The first three options, "l," "n," and "a," use the mouse to point to specific features. Interactive instructions will appear on the dumb terminal screen (or the shell window if only a graphics monitor is used). Like the *Edit Menu*, most debugging operations using the mouse follow a *left-right* button sequence for first, *choosing*, and second, *accepting*, the function. The middle button is used to quit the current function. All the options are similar; the following example is for a line: "l - Display Line Info."
Choose Line:

Buttons:
Left: Choose line
Middle: Abort/Quit
Right: Accept chosen line

After selecting the feature, it will be highlighted (default color yellow) on the graphics screen. Other information will appear on the screen where the global menu (bottom menu) had been. It appears in the following format (again, a line is used as an example).

<table>
<thead>
<tr>
<th>Line#: 8</th>
<th>Category: 2</th>
</tr>
</thead>
<tbody>
<tr>
<td># 8:</td>
<td>N1 8 N2 9 Left 0 Right 0</td>
</tr>
<tr>
<td>Att 13 (index 8)</td>
<td>Category 2</td>
</tr>
</tbody>
</table>

The arcane descriptions above refer to the internal coordinates defining the spatial topology of the line. For example, the Line # is 8, meaning it was the eighth line digitized in the sequence. It has been labeled category 2. It is linked to two nodes, #8 and #9, and begins at #8. It is the 13th in the series of labeled features, and the (x,y) UTM coordinates of node 8 are provided. The Left and Right fields refer to area designations; e.g., if the lines bounded labeled areas, what area is "left" of the line and what area is "right" of the line. However, since this line is not an area edge, the fields are categorized as "0".

The KEYBOARD commands are somewhat more flexible and provide the user more information, for example: "L - Find Line." Within the global menu field the following information will appear:

Enter <CR> for next line, # of desired line, 'q' quit:
# 1: N1 1 N2 1 Left 0 Right 0
Line is NOT labeled
Total lines: 31

The user can proceed through the sequence of features by pressing the <RETURN> key, or if known, the number of the feature in question. In the example above, there are 31 total line features occurring within the vector data layer. Options "N" and "A" function similarly. Other functions are described below.

I - Find Isle
Highlights "island" polygons, or areas completely surrounded by, or embedded within, other areas, and describes the lines defining them.

d - Display Node-Lines
Functions similarly to the "Display Node Lines" option within the Toolbox Menu.

q - Return from whence we came
Returns to the previous menu.

After locating the problem features, the user has several options to modify them. One way is to use other v-digit menus, such as Edit or Label and remove or change the suspect feature. Another more involved procedure is to change the binary vector file into ascii format using the v.out.ascii program. This creates a text file within the dig_ascii directory within the current mapset. The file can then be edited using "vi" and then converted back to a binary file using the v.in.ascii program. Other programs like v.support or v.clean can also be used.
17. EXITING v.digit

To exit the v.digit program, return to the Main Menu and type "Q" to "Quit." The following message appears:

```
Leave digit? [n]
```

To leave, type "y" and <RETURN> after the query. If any modifications to the vector file have been performed, the following sequence appears in rapid succession:

```
Compressing Data: DONE
Compressing NODES. LINES. AREAS. ISLES. ATTS. Writing Plus File . . . DONE.
Do you want to compress the Atts file [n]
```

This query refers to the vector file in the dig att directory in the user’s GRASS mapset. In most cases, the user wants to answer with the default, [n]. This way, all information about the file, both old and new, is retained, although it is only the newer that is accessed in future sessions. Until you are certain that the file is entirely completed, answer "n."

If the user answers "y," the program deletes the attributes from the file that are not represented in the current version of the vector file. Examples of such items include the old labels for relabeled features, changes in topology, etc. The effect is to "clean" the attribute file for the vector layer created or modified during the just completed digitizing session. In this way the attribute file is brought in line with the most current version of the map. In addition, if error messages about duplicate attributes are encountered when running v.support, these can sometimes be eliminated by answering positively to the above prompt. Upon exiting v.digit, you will be returned to the GRASS prompt.
REFERENCES


